Arduino Tutorial Common Syntax

Serial Monitor Output
Serial.begin (9600); : Connects the program to the serial monitor
Serial.print: Prints text in the dialogue box. Used for output readings from the Arduino board.
Serial.println(): Drops cursor down to the next line on the serial monitor
Serial.parseInt() or Serial.parseFloat(): Allows user to read either integer or real numbers for input
Serial.flush(); : Waits for transmission of outgoing data to be complete
Serial.available(); : Waits until the input buffer has a character

Digital/Analog Commands
digitalWrite or analogWrite: Write code to the Arduino board (I.E digitalWrite (13, HIGH) = Turns LED light linked to Pin 13 On)
digitalRead or analogRead: Reads information from the Arduino Board. Typically used with a switch or sensor to determine if contact is being made (I.E digitalRead (5, Low) = Switch/Sensor linked to Pin 5 on the Arduino board is not making contact)
Serial.read: Reads and Output information from a specified pin on the Arduino Board or keyboard (NOTE Keyboard input will always read as character variable (even numbers)

Power Transfer/Wait Time
HIGH: Power transferred or switch will read in contact (On)
LOW: Power is not transferred or switch will read not in contact (Off)
delay(): Will pause the program for x number of milliseconds (NOTE: 1000 milliseconds = 1 second)

Pin Declaration
pinMode (): Declares the numbered pin to be either input or output (I.E pinMode (13, INPUT); or pinMode (13, OUTPUT)

NOTE: All Loops (for, while, do/while), if/then, if/else syntax is the same as learned in previous lessons
Basic Anatomy of the Arduino Board

Breadboard Setup

- All holes in this row are connected
- All holes in this row are connected
- All holes in each column are connected
- All holes in each column are connected
- All holes in this row are connected
- All holes in this row are connected
Resistor values are marked using colored bands, according to a code developed in the 1920s, when it was too difficult to write numbers on such tiny objects.

Each color corresponds to a number, as shown in the table below. Each resistor has either 4 or 5 bands. In the 4-band type, the first two bands indicate the first two digits of the value while the third one indicates the number of zeros that follow (technically it represents the power of ten). The last band specifies the tolerance; in the example below, gold indicates that the resistor value can be 10k ohms plus or minus 5%.

**How to Read Resistor Color Codes**

- **1st Digit**
  - 0
  - 1
  - 2
  - 3
  - 4
  - 5
  - 6
  - 7
  - 8
  - 9

- **2nd Digit**
  - 0
  - 1
  - 2
  - 3
  - 4
  - 5
  - 6
  - 7
  - 8
  - 9

- **3rd Digit**
  - 0
  - 1
  - 2
  - 3
  - 4
  - 5
  - 6
  - 7
  - 8
  - 9

- **Multiplier**
  - 1
  - 2
  - 3
  - 4
  - 5
  - 6
  - 7
  - 8
  - 9

- **Tolerance**
  - ±1%
  - ±2%
  - ±5%
  - Gold
  - ±10%
  - Silver

---

**4 Band Example**

1 0 \( \times 10^3 \) 5 = 10,000 \( \Omega \) 10k \( \Omega \) ±5%

**5 Band Example**

1 0 0 \( \times 10^2 \) 5 = 10,000 \( \Omega \) 10k \( \Omega \) ±5%
Workspace Setup

NOTE: It is not necessary to declare the `#include <iostream>` library or to `int main()` in your program. Those codes are prebuilt into the structure of the Arduino program.

NOTE: Change Font Height of Text: Pull Down Menu File > Preferences > Font > Change to desired text height

Connecting Arduino Uno to the Computer

NOTE: These steps should be done each time Arduino Software is used.

1. Using the USB-Fire Wire connector, connect the Arduino Board to the computer
2. Open Arduino Software from the desktop
3. Setting up Arduino Board
   a. Tools > Board > Select Arduino Uno
   b. Tools > Port > Select the Com# Port that has (Arduino Uno) in parentheses (NOTE: if Arduino Uno does not show up; look at the list of ports > unplug the wire see which port disappears (remember the number) > replug the wire in and choose the port that had disappeared from the list in the previous step)
   c. Tools > Programmer > USBasp
      This will set the communication between the PC and the Arduino

Software provides 2 default functions:

- `void setup(){}`: only runs the code between braces one time
- `void loop(){}`: runs code between the braces infinitely. There is no way to end it. However, program can be designed in a way to trap the program in an infinite loop that will not execute any commands within the loop

Upload: Sends code to Arduino
Verify: Compiles code and outputs any errors
Dialogue Box: Verify Program or show errors
Program 1: Flashing Light and Hello World!

Part 1: Turn on a light for a specified duration

Schematic

Connections

<table>
<thead>
<tr>
<th>Step</th>
<th>Component</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wire</td>
<td>Arduino 5V</td>
<td>Breadboard – (negative) Line 1</td>
</tr>
<tr>
<td>2</td>
<td>LED</td>
<td>Breadboard: Short Side of LED E8</td>
<td>Breadboard: Long Side of LED E9</td>
</tr>
<tr>
<td>3</td>
<td>Wire</td>
<td>Arduino: Pin 13</td>
<td>Breadboard: A8</td>
</tr>
<tr>
<td>4</td>
<td>Resistor 220 Ohm (Red, Red, Brown, Gold)</td>
<td>Breadboard: - Row 10</td>
<td>Breadboard: C9</td>
</tr>
</tbody>
</table>

NOTE: Connection ports DO NOT need to be the same as long as the wires and electrical components match up properly.

NOTE: LED Anode (Long Leg) should always be linked to the resistor and Cathode (short Side) linked to the ground or the direction the circuit is going.

Long Leg = Electricity In, + (Positive)

Short Leg = Electricity Out, - (Negative)
Program Code

Type following code

```c
void setup() {
  // put your setup code here, to run once:
  pinMode (13, OUTPUT);  // Declares that port 13 is only setup to output
  digitalWrite (13, HIGH); // Sends a signal to port 13 to open electricity to flow through the port turning the LED on
  delay (1000); // Allows power to flow to through port 13 for 1000ms (or 1 second)
  digitalWrite (13, LOW); // Turns power off to port 13; turning the light off.
}

void loop() {
  // put your main code here, to run repeatedly:
}
```

Save Program as Blink

Connect the Arduino Board to the computer using the USB-Fire Wire Cable.

NOTE: If board is not connected through a COM port unplug the board and reconnect with the steps listed above (Page 4 Connecting Arduino Board to Computer)

Result: Light should turn on for 1 second and then turn off

Part 2: Make the light blink repeatedly

1. Copy the code from the void setup() and paste in the void loop() 2.
   Add a delay statement after the digitalWrite (13, LOW) of 200.
3. This will make the light flash on and off repeatedly. Experiment in changing the delays to alter the flashing of the light.
Part 3: Adding Input/Output, Variables, If/Statement, and Loops

Delete the Blink Code; Type the following Code

```cpp
// Program: Adding Two Numbers

float number1, number2, sum;

char junk = ' ';  // Variable used to erase bad input

void setup()
{
  Serial.begin (9600);  // Connects user to Serial Monitor for Output on Screen
  Serial.println ("Let's calculate sum");  // Serial.println() places Text on Serial Monitor
  Serial.flush();  // the ln of code moves cursor down to the next line after output
  // Waits for the transmission of outgoing data to complete
}

void loop()
{
  // Input Process for Number 1
  Serial.println ("Enter Number 1: ");
  while (Serial.available() == 0);
  number1 = Serial.parseFloat();  // Serial.parseFloat() returns the first valid number from the Serial Buffer
  Serial.print ("Number 1 = ");
  Serial.println (number1);
  while (Serial.available() > 0)  // Removes non-numeric characters from the buffer
  {
    junk = Serial.read();  // Clears the Keyboard Buffer for next input
  }

  // Input Process for Number 2
  Serial.println ("Enter Number 2: ");
  while (Serial.available() == 0);
  number2 = Serial.parseFloat();  // Serial.parseFloat() returns the first valid number from the Serial Buffer
  Serial.print ("Number 2 = ");
  Serial.println (number2);
  while (Serial.available() > 0)  // Removes non-numeric characters from the buffer
  {
    junk = Serial.read();  // Clears the Keyboard Buffer for next input
  }
}

sum = number1 + number2;  // Calculates Sum
Serial.print ("Sum = ");
Serial.println (sum);  // Outputs Sum
```
2. Modify the code to do the following
   a. Change the code to calculate the volume of a cone
   b. Flash the lights as follows
      i. Volume < 100
         - Flash ON = 2 sec
         - OFF = 2sec
         - 3 Times (USE For Loop or Do/While Loop)
      ii. 100 <= Volume <= 500
         - Flash ON = 1 sec
         - OFF = 3 sec
         - 3 Times (USE For Loop or Do/While Loop)
      iii. Volume > 500
         - Flash ON = .5 sec
         - OFF = 2sec
         - 3 Times (USE For Loop or Do/While Loop)

Part 4: Limiting the times through the loop

   NOTE: There is no way to exit the Void Loop() in Arduino. However a delay statement or moving into a loop that does nothing can solve this problem. (I.E delay (100000000); or Create a Loop: while (TRUE) {} (while TRUE will always make the loop true so it will run infinitely.) Modify the program to do the following

   1. After the first time through the program ask the user of they want to find the volume of another cone. Use 0 or Yes and 1 for No
      a. If Yes repeat the program
      b. If No end the program and say “Goodbye!”
Program 2: Switch Statement

Circuit Design

NOTE: LED Anode (Long Leg) should always be linked to the resistor and Cathode (short Side) linked to the ground or the direction the circuit is going.

Long Leg = Electricity In, + (Positive)

Short Leg = Electricity Out, - (Negative)
Program Code

Switch statement is like an If/Else/If/Else Statement. It only allows the user to compare discrete values (one thing at a time). It is not possible to compare ranges of objects. (For that an If statement is needed).

Program uses the Serial Monitor. Type in the characters a, b, c, d, e will turn on the LEDs they are connected to.

```c
void setup() {
  // initialize serial communication:
  Serial.begin(9600);
  // initialize the LED pins:
  for (int thisPin = 2; thisPin < 7; thisPin++) {
    pinMode(thisPin, OUTPUT);
  }
}

void loop() {
  // read the sensor:
  if (Serial.available() > 0) {
    int inByte = Serial.read();
    // do something different depending on the character received.
    // The switch statement expects single number values for each case;
    // in this example, though, you're using single quotes to tell
    // the controller to get the ASCII value for the character. For
    // example 'a' = 97, 'b' = 98, and so forth:
    switch (inByte) {
      case 'a':
        digitalWrite(2, HIGH);
        break;
      case 'b':
        digitalWrite(3, HIGH);
        break;
      case 'c':
        digitalWrite(4, HIGH);
        break;
      case 'd':
        digitalWrite(5, HIGH);
        break;
      case 'e':
        digitalWrite(6, HIGH);
        break;
      
    }
  }
}
```

Using a Switch/Case statement is the equivalent of writing multiple If/Else Statements

For Example:

```c
Switch (inByte) {  case ‘a’: }  

is equivalent to writing
if (inByte == ‘a’)

{then do this line(s) of code}
```
Upload the program to test it.
Notice how when one key is pressed then another the light of the previous key does not turn off.

**Assignment: LED Lights** Modify the program to do the following

1. Only have the inputted LED Lamp Turned ON (All other LED’s turn off with each new input) I.E. When ‘a’ is pressed ‘a’ LED light is on, then when ‘b’ is pressed the ‘b’ LED light is on and the ‘a’ LED is turned off.

2. Output if Input is NOT a, b, c, d, or e
   a. Blink all of the LED Lamps for a duration of 2 seconds
   b. Output in the Serial Monitor “ERROR, INPUT INVALID!”

(HINT: if inbyte < 97 || inbyte > 101)

**NOTE:** Serial.read converts all input to ASCII code form. See below of values

<table>
<thead>
<tr>
<th>DEC Value</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>space</td>
</tr>
<tr>
<td>33</td>
<td>!</td>
</tr>
<tr>
<td>34</td>
<td>&quot;</td>
</tr>
<tr>
<td>35</td>
<td>#</td>
</tr>
<tr>
<td>36</td>
<td>$</td>
</tr>
<tr>
<td>37</td>
<td>%</td>
</tr>
<tr>
<td>38</td>
<td>&amp;</td>
</tr>
<tr>
<td>39</td>
<td>'</td>
</tr>
<tr>
<td>40</td>
<td>(</td>
</tr>
<tr>
<td>41</td>
<td>)</td>
</tr>
<tr>
<td>42</td>
<td>+</td>
</tr>
<tr>
<td>43</td>
<td>,</td>
</tr>
<tr>
<td>44</td>
<td>-</td>
</tr>
<tr>
<td>45</td>
<td>/</td>
</tr>
<tr>
<td>46</td>
<td>0</td>
</tr>
<tr>
<td>47</td>
<td>1</td>
</tr>
<tr>
<td>48</td>
<td>2</td>
</tr>
<tr>
<td>49</td>
<td>3</td>
</tr>
<tr>
<td>50</td>
<td>4</td>
</tr>
<tr>
<td>51</td>
<td>5</td>
</tr>
<tr>
<td>52</td>
<td>6</td>
</tr>
<tr>
<td>53</td>
<td>7</td>
</tr>
<tr>
<td>54</td>
<td>8</td>
</tr>
<tr>
<td>55</td>
<td>9</td>
</tr>
<tr>
<td>56</td>
<td>:</td>
</tr>
<tr>
<td>57</td>
<td>;</td>
</tr>
<tr>
<td>58</td>
<td>&lt;</td>
</tr>
<tr>
<td>59</td>
<td>=</td>
</tr>
<tr>
<td>60</td>
<td>&gt;</td>
</tr>
<tr>
<td>61</td>
<td>?</td>
</tr>
<tr>
<td>62</td>
<td>a</td>
</tr>
<tr>
<td>63</td>
<td>b</td>
</tr>
<tr>
<td>64</td>
<td>c</td>
</tr>
<tr>
<td>65</td>
<td>d</td>
</tr>
<tr>
<td>66</td>
<td>e</td>
</tr>
<tr>
<td>67</td>
<td>f</td>
</tr>
<tr>
<td>68</td>
<td>g</td>
</tr>
<tr>
<td>69</td>
<td>h</td>
</tr>
<tr>
<td>70</td>
<td>i</td>
</tr>
<tr>
<td>71</td>
<td>j</td>
</tr>
<tr>
<td>72</td>
<td>k</td>
</tr>
<tr>
<td>73</td>
<td>l</td>
</tr>
<tr>
<td>74</td>
<td>m</td>
</tr>
<tr>
<td>75</td>
<td>n</td>
</tr>
<tr>
<td>76</td>
<td>o</td>
</tr>
<tr>
<td>77</td>
<td>p</td>
</tr>
<tr>
<td>78</td>
<td>q</td>
</tr>
<tr>
<td>79</td>
<td>r</td>
</tr>
<tr>
<td>80</td>
<td>s</td>
</tr>
<tr>
<td>81</td>
<td>t</td>
</tr>
<tr>
<td>82</td>
<td>u</td>
</tr>
<tr>
<td>83</td>
<td>v</td>
</tr>
<tr>
<td>84</td>
<td>w</td>
</tr>
<tr>
<td>85</td>
<td>x</td>
</tr>
<tr>
<td>86</td>
<td>y</td>
</tr>
<tr>
<td>87</td>
<td>z</td>
</tr>
<tr>
<td>88</td>
<td>[</td>
</tr>
<tr>
<td>89</td>
<td>\</td>
</tr>
<tr>
<td>90</td>
<td>]</td>
</tr>
<tr>
<td>91</td>
<td>^</td>
</tr>
<tr>
<td>92</td>
<td>_</td>
</tr>
<tr>
<td>93</td>
<td>~</td>
</tr>
<tr>
<td>94</td>
<td>`</td>
</tr>
<tr>
<td>95</td>
<td>a</td>
</tr>
<tr>
<td>96</td>
<td>b</td>
</tr>
<tr>
<td>97</td>
<td>c</td>
</tr>
<tr>
<td>98</td>
<td>d</td>
</tr>
<tr>
<td>99</td>
<td>e</td>
</tr>
<tr>
<td>100</td>
<td>f</td>
</tr>
<tr>
<td>101</td>
<td>g</td>
</tr>
<tr>
<td>102</td>
<td>h</td>
</tr>
<tr>
<td>103</td>
<td>i</td>
</tr>
<tr>
<td>104</td>
<td>j</td>
</tr>
<tr>
<td>105</td>
<td>k</td>
</tr>
<tr>
<td>106</td>
<td>l</td>
</tr>
<tr>
<td>107</td>
<td>m</td>
</tr>
<tr>
<td>108</td>
<td>n</td>
</tr>
<tr>
<td>109</td>
<td>o</td>
</tr>
<tr>
<td>110</td>
<td>p</td>
</tr>
<tr>
<td>111</td>
<td>q</td>
</tr>
<tr>
<td>112</td>
<td>r</td>
</tr>
<tr>
<td>113</td>
<td>s</td>
</tr>
<tr>
<td>114</td>
<td>t</td>
</tr>
<tr>
<td>115</td>
<td>u</td>
</tr>
<tr>
<td>116</td>
<td>v</td>
</tr>
<tr>
<td>117</td>
<td>w</td>
</tr>
<tr>
<td>118</td>
<td>x</td>
</tr>
<tr>
<td>119</td>
<td>y</td>
</tr>
<tr>
<td>120</td>
<td>z</td>
</tr>
<tr>
<td>121</td>
<td>[</td>
</tr>
<tr>
<td>122</td>
<td>\</td>
</tr>
<tr>
<td>123</td>
<td>]</td>
</tr>
<tr>
<td>124</td>
<td>^</td>
</tr>
<tr>
<td>125</td>
<td>_</td>
</tr>
<tr>
<td>126</td>
<td>`</td>
</tr>
<tr>
<td>127</td>
<td>a</td>
</tr>
</tbody>
</table>
Program 3: Push Button

Source Code

```c
/*
  * Button
  * Turns on and off a light emitting diode(LED) connected to digital pin 13, when pressing a pushbutton attached to pin 2. The circuit:
  * 1 LED attached from pin 13 to ground
  * 2 pushbutton attached to pin 2 from +5V
  * 3 10K resistor attached to pin 2 from ground
  * Note: on most Arduinos there is already an LED on the board attached to pin 13.
  */

// constants won't change. They're used here to
// set pin numbers:
const int buttonPin = 2;  // the number of the pushbutton pin
const int ledPin = 13;  // the number of the LED pin

// variables will change:
int buttonState = 0;  // variable for reading the pushbutton status

void setup() {
  // initialize the LED pin as an output:
  pinMode(ledPin, OUTPUT);
  // initialize the pushbutton pin as an input:
  pinMode(buttonPin, INPUT);
}

void loop() {
  // read the state of the pushbutton value:
  buttonState = digitalRead(buttonPin);

  // check if the pushbutton is pressed,
  // if it is, the buttonState is HIGH:
  if (buttonState == HIGH) {
    // turn LED on:
    digitalWrite(ledPin, HIGH);
  } else {
    // turn LED off:
    digitalWrite(ledPin, LOW);
  }
}
```

Wiring Diagram Option 1
Direct Wiring to Arduino

- Grey Wire: Out goes to Port 13
- Brown Wire: GND goes to GND
- Red Wire: VCC to 5V

Wiring Diagram Option 2
Direct Wiring to Arduino

- Brown Wire: Ground (GND) to Arduino Ground (GND)
- Red Wire: Voltage (VCC) to Arduino 5V
- Grey Wire: Out to Arduino Port 13

Shows what each pin represents
Align each wire in the same row as the pin connection

TOP
FRONT
BACK
LEFT SIDE
Assignment: Push Button

1. Modify the program so the serial monitor screen shows
   a. Text On (Button Pressed) and Off (Button Released)
   b. Counter showing how many times the button has been released

2. Limit of On/Off
   a. Maximum presses = 5
   b. Once Limit is met do the following
      i. Stop the light from turning on and off when button is pressed
      ii. Serial Port Print “ALL DONE!”
      iii. Only print “ALL DONE!” twice on separate lines
           (Serial.println)
Program 4: Ultrasonic Sensor
Source Code

/*
HC-SR04 Ping distance sensor:
VCC to arduino 5v
GND to arduino GND
Echo to Arduino pin 7
Trig to Arduino pin 8

This sketch originates from Virtualmix: http://goo.gl/kJ6G1
Has been modified by Winkle ink here:
And modified further by ScottC here:
sensor.html
on 10 Nov 2012.
*/
#define echoPin 7 // Echo Pin
#define trigPin 8 // Trigger Pin
#define LEDPin 13 // Onboard LED

int maximumRange = 200; // Maximum range needed
int minimumRange = 0; // Minimum range needed
long duration, distance; // Duration used to calculate distance

void setup() {
  Serial.begin (9600);
pinMode(trigPin, OUTPUT);
pinMode(echoPin, INPUT);
pinMode(LEDPin, OUTPUT); // Use LED indicator (if required)
}

void loop() {
  /* The following trigPin/echoPin cycle is used to determine the
  distance of the nearest object by bouncing soundwaves off of it. */
digitalWrite(trigPin, LOW);
delayMicroseconds(2);

digitalWrite(trigPin, HIGH);
delayMicroseconds(10);

digitalWrite(trigPin, LOW);
duration = pulseIn(echoPin, HIGH);

//Calculate the distance (in cm) based on the speed of sound.
distance = duration/58.2;

if (distance >= maximumRange || distance <= minimumRange) {
  /* Send a negative number to computer and Turn LED ON
to indicate "out of range" */
  Serial.println("-1");
digitalWrite(LEDPin, HIGH);
}

else {
  /* Send the distance to the computer using Serial protocol, and
turn LED OFF to indicate successful reading. */
  Serial.println(distance);
digitalWrite(LEDPin, LOW);
}

//Delay 50ms before next reading.
delay(50);
}
Upload Program and Test it. NOTE the program will print the distance in the serial port

**Assignment:** Ultrasonic Sensor

1. Add a 220 Ohm resistor and LED on the circuit
2. Turn the light on when the an object gets with 20cm of ultrasonic sensor and turns off when it is out of range

**Program 5: Photoresistor Sensor**

Allows the user to implement a variable resistor that uses light to determine the resistances on the circuit based on the intensity of the light. Can also be used to sense the amount to light intensity around the photoresistor and then can activate other circuits given a defined set of constraints.

**Wiring Diagram**

---

*Ground Wire is not necessary in this case since we just want to see how much light is present.*

*Voltage Wire is not needed as well since the surrounding light could supply the power if needed and adjust based on the intensity of the light.*

*Legs of the photoresistor are the same. Does not matter which leg the wire lines up to.*
Write the following program

```c
int sensorPin = A0; //sets the photoresistor to Port A0 on the Arduino Board
int value = 0;

void setup()
{
  Serial.begin(9600);
}

void loop()
{
  value = analogRead (sensorPin); //Reads the amount of light on the photoresistor
  Serial.println(value,DEC); //Converts the sensor reading to a decimal value
  delay(50); //Provides Time between Readings
}
```

Testing:
Upload the program
a. Open the Serial Monitor
b. Place your hand over the Photoresistor > Notice the value change. Analyze the data
c. Close the Serial Monitor > Click on Tools Drop down menu > Select Serial Plotter > now the data is graphed. Analyze the data

Assignment: Simulate Morning, Day and Night Without Looking out the Window
Modify the code that can do the following.
Wire 3 different color LEDs to Digital Ports 1,2,3 (May consider using a Switch/Case for comparison)
Declare 3 different ranges (I.E 0-100 = Night)
1. Represents Dawn/Dusk = Middle Values
2. Represents Day = Highest Values (Maximum amount of light)
3. Represents Night: Lowest Values (Least amount of light)